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INTRODUCTION TO WORKSTREAM

ZBE WorkStream is professional software comprised of two independent, yet integrated, 
products, one for the professional photographer and one for the lab. It simplifies, controls and 
automates digital print production in the photographer’s studio and in the photo lab.

WORKSTREAM DS 
WorkStream DS (Digital Studio) runs in the photographer's studio. It provides a 
comprehensive image management and library system. WorkStream DS is used to prepare 
images and orders that will be printed at the photo lab. All aspects of the order can be 
entered by the photographer including image color corrections, cropping and composition, 
retouching and product selection. WorkStream DS automatically generates an order archive 
and database for the studio. The order is then transferred seamlessly to a photo lab running 
WorkStream IA for automated production.

WORKSTREAM IA 
WorkStream IA (Imaging Automation) manages the production process in the digital photo 
lab or imaging service bureau. WorkStream IA handles all aspects of order creation, 
management and production from order entry and scanning, through color correction, 
cropping and retouching, to scheduling and printing.

RECOMMENDED SPECIFICATIONS
z Operating System: Windows 2000 or XP Professional
z Processor: Pentium 4, at least 2 Ghz (or equivalent)
z RAM: 512 MB
z Hard Drive: At least 10 GB free
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WORKSTREAM REGISTRATION
When you first start WorkStream, you will see the following dialog:

Y

In this dialog, you have four options:
z Begin Free Trial: Click this to use WorkStream DS without registering. When your 

trial has expired, you must register WorkStream DS using one of the options 
described below.

z Register on ZBE’s Website: Choose this option if you have an internet connection, 
but have not yet created an account on ZBE’s website. See "Register on ZBE’s 
Website" below. 

z Register WorkStream using an existing account: If you have an internet 
connection and an account on our website, enter your account information to register. 
For more information, see "Register WorkStream using an existing account" on 
page 4.

z Register without an Internet Connection: If you do not have an internet connection, 
you must select this option. See "Register without an Internet Connection" on page 4.
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Introduction to WorkStream
REGISTER ON ZBE’S WEBSITE
1. If you chose Register WorkStream on www.zbe.com on the registration dialog, your 

browser will open to ZBE’s website. 

After you have created the account, you will need to check the email address you 
provided for an automated email from ZBE (support@zbe.com).

2. Click the link provided in that email in order to validate your email address.

You will be taken to the confirmation page:

3. Your account has been created. 

4. Restart WorkStream.

5. Select Register WorkStream using an existing account on the Registration Dialog 
shown at the top of this document. 

Click the Register WorkStream link. 
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6. Enter your login and password information, then press Continue. 

7. Your registration is complete.

REGISTER WORKSTREAM USING AN EXISTING ACCOUNT
Choosing Register WorkStream using an existing account, will enable the Login and 
Password fields on the Register Dialog.

1. Enter your Login and Password for your account on ZBE’s website. 

2. If you can’t remember your password, go to

http://www.zbe.com/usergroups/CustomerForgotPassword.jsp (this is case sensitive). 
On this page, you will be prompted to enter your login for ZBE’s website. When you 
press Send Password by Email, your password will be sent to the email account that 
was specified when you created the account.

3. Once your Login and Password have been entered, press Continue.
4. WorkStream has now been registered on this computer. It will now start. 

REGISTER WITHOUT AN INTERNET CONNECTION
If you chose Register WorkStream (select this option if you do not have an internet 
connection) above, the following dialog will appear:

1. Press Print Registration Form to get a hard copy of the information you will need to 
register your copy of WorkStream DS. 
4 Using WorkStream DS
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Introduction to WorkStream
2. If you have access to a computer with an internet connection, continue to step 3. 
Otherwise, contact your lab and provide them with the information on the Registration 
Form. They will provide you with a registration code. When you have received a 
registration code, continue to step 14.

3. If you do not have an account on ZBE’s website, create one, following steps 4-5. If you 
already have an account, skip to step 6.

4. Go to http://www.zbe.com/usergroups/CustomerRegister.jsp (this is case sensitive).

After you have created the account, you will need to check the email address you 
provided for an automated email from ZBE (support@zbe.com).

5. Click the link provided in that email in order to validate your email address.

You will be taken to the confirmation page:

Click the Register WorkStream link. 
Using WorkStream DS 5
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6. Your account has been created. Enter your login name and password at http://
www.zbe.com/support.html:

7. Select Software Registration in the WorkStream DS section:

8. Select Get Registration Code:

9. Fill in the name for the machine you wish to register WorkStream on. This does not have 
to be the actual machine name. Filling in a name helps you keep track of which computer 
a registration code belongs to.

10. Enter the Machine ID for the machine you wish to register WorkStream on.

11. Press the Get Registration Code button.

Click "Software 
Registration"
6 Using WorkStream DS
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Introduction to WorkStream
12. On the next page, your code will appear:

13. Copy the registration code down onto your registration form. Make sure you have copied 
it exactly: the number 0 and the letter O look very similar. 

14. Enter the registration code into the Registration Code Dialog, which will appear when 
you select Register WorkStream (Select this option if you do not have an internet 
connection).

NOTE: It is important to enter the Registration code exactly. When entering the Registration Code, or reading 
the Machine ID over the phone, note carefully the difference between the letter O and the number 0, 
which look very similar. The letter I and the number 1 may also look similar. If the number 8 and the 
letter B start looking similar, you have probably been working too long. Take a break!

15. Press Continue. WorkStream will start.

INSTALLING AND CONFIGURING WORKSTREAM DS
Using WorkStream Digital Studio (DS), you can submit orders directly to a photo lab running 
WorkStream Imaging Automation (IA). 

To make this seamless transfer of images possible, the photo lab will provide you with a 
configuration file with that lab’s settings. The configuration file includes information about the 
photo lab and the types of prints they can produce for you (for example, print sizes, types of 
packages, and types of materials). When you run the file, the WorkStream DS software on 
your computer is automatically configured to match the products offered by the photo lab.

To install WorkStream DS on your computer, follow these steps.
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1. Copy the WorkStreamDSSetup.EXE file onto your computer. Double-click to launch the 
installation program.

2. Follow the instructions on the screen to install WorkStream. The installation wizard 
identifies a standard location for the program (C:\Program Files\WorkStream DS) which 
you can change if necessary.

3. Once WorkStream DS is installed, it must be registered. To register, see "WorkStream 
Registration" on page 2.

4. When the program installation and registration is complete, the Welcome page appears:
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Introduction to WorkStream
5. If you selected Advanced Setup, Press Next. The Lab Settings search begins.

6. Locate the configuration file provided by your photo lab by clicking one of the buttons:

z I don’t have a configuration file yet
z I will browse for my configuration file
z Auto Search for my configuration file

7. Click Finish.

8. If you wish to store your files on a network, you may re-run the setup wizard at any time, 
and choose the Advanced mode.

9. You are now ready to start using WorkStream.

Note: If you need to rerun the Configuration wizard at any time, select Setup Wizard from the Tools menu.

SUPPORTED FILE TYPES
WorkStream supports the following file types:

BMP, JPEG and 8-bit RGB TIFFs, both LZW and not compressed and grayscale TIFFs.
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TAKING A FIRST LOOK AT THE DS SCREEN
The WorkStream Digital Studio screen gives you access to many tools. Here is a quick look 
at some of the basic panels on the screen. You will find detailed information on all these 
capabilities in later sections of this manual.

When you use WorkStream, you can arrange the information you see on the screen in a 
number of ways. These arrangements are called views. For detailed information about views, 
see "Screen Views and Layouts" on page 67.

The view you will probably use most often while preparing images is the DS View, shown 
above. To open the DS view, select DS View from the Views menu and Switch To from the 
submenu.

Images Panel: In this area you can view 
all the images of an order either as 
thumbnails or at full size. You can modify 
images and apply print products.

Product Panel: In this area you 
select the specific products for 
each image.

Products Tree: Use the 
context menu options 
here to move between 
products and crop them.
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Control bars

Toolbar
The toolbar contains icons for quickly performing tasks, such as creating an order, opening a 
reference image, or rotating from one view to another. It consists of five sub-bars.

.

Basic Settings Bar: Edit product settings. Use the arrow buttons to 
enter Product Notes and Options.

Products Panel: Select print products for each image or group of 
images. Use the tabs at the bottom of the panel to use different product 
types such as Templates, Logos, Index Prints, and more.

Products Tree: This panel displays the products for the current 
image. It is often used to navigate between products. Right click on 
any of the products or components to crop.

Orders bar: Create new order, 
open an existing order, save an 
order, import an order, or export 
an order.

Navigation bar: 
Move forward or 
backward through 
images or products.

Features bar: Scan in 
an image, retouch an 
image, or display a 
reference image.

Image bar: Clear the 
screen, browse for images, 
rotate to a different view, or 
enter Presentation mode.
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ORDERS

WHAT IS AN ORDER?
An order in WorkStream consists of a number of prints produced from a group of images. 
Orders are created by selecting the images to be printed and specifying the print sizes, 
quantities, types, crops, and color adjustments for each image. Once an order is created, it 
can be saved for future reference in WorkStream's built-in database.

As you prepare an order, you work with the images onscreen as a series of thumbnails. The 
print product(s) you select for each image (for example, "8 Wallets" or "2 5x7s") are listed 
beneath the image. 

Individual images within the order may be cropped, rotated, sharpened, and color adjusted (if 
permitted by the photo lab). To view the results of these adjustments, double-click a 
thumbnail image to open a large view of that image. 

CREATING AN ORDER
To create an order, you simply select a customer, choose the images to be printed, and apply 
the appropriate product(s) to each image.
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Orders
1. If the screen is not already in DS View, switch to it by selecting DS View from the View 
menu and Switch To from the submenu.

2. From the File menu, select New Order or press the New Order button on the Orders 
Bar.

3. In the Customer drop-down list, select the customer for this order. For new customers, 
see "Adding a new customer" on page 20.

4. In the Order Number edit box, choose an order number or click Get Next Order Number 
to assign the next available number automatically. 

5. Click Next.

Selecting images
The dialog boxes you see next vary, depending on whether you have an image open on the 
screen. If there are no images open, the wizard asks you to locate the images you want to 
use. Continue with the next step.

Identify the images for this order in one of the following ways.

If the image IS NOT part of an existing order: 
a. Click the Select button under Browse for Images.

Click here if the image is new, not part of an 
existing order.

Click here if the image is not new but part of an 
existing order.
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b. Click the Browse button.

c. Navigate to the appropriate folder and select the images you want for this order. You 
can use Shift-click and Control-click to select groups of images. When you have 
selected all the images, click Open.

d. Click the drop-down arrow to identify where you want the images to be stored.

e. Click Finish.

If the image IS part of an existing order
a. Click the Select button under Use Images from Another Order.
b. Click the drop-down arrow and select the appropriate order.

c. Click Finish

z Use images in current 
location

The images remain in the directory where they are. 
No copies are placed in the WorkStream Image 
Storage Location.

z Copy images to storage The images are copied into the WorkStream Image 
Storage Location, but they are not deleted from their 
current directory. All images exist in two locations.

z Move images to storage The images are moved to the WorkStream Image 
Storage Location and deleted from their current 
location.
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Orders
Adding products
Once you have added the images to the order, you can select as many print products for 
each image as you need.

1. Click an image once to select it. Use Shift-click to select multiple images. A blue border 
appears around the selected image(s).

2. In the Product panel, select the desired tab.

3. Double-click the product(s) to use for the selected image(s).

Note: WorkStream gives you great flexibility in selecting print products. You can print as many products from 
an image as you want. You can easily select different products for each image or selected group of 
images. For complete details, see "Products" on page 27.

Double-click an icon to apply that product to an image.

Click the tabs to view different groups of available products.
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ADDING IMAGES TO AN ORDER
1. Open the order in one of the following ways:

z To open an existing order, see "Opening an existing order" on page 20.
z To create a new order, select New Order from the File menu. (See "Creating an order" 

on page 12.)

2. To add images to an order, click the Browse button.

3. Using the Browse dialog box, browse through the files to locate the images you want to 
add.

You can browse to a particular image or group of images and open them. 

Alternately, you can open an entire folder automatically by selecting the folder and 
clicking Open. It doesn't matter if some of the files in the folder are not image files. If 
Open Non-Image Files is checked, any type of file can be added to an order and will 
appear as a thumbnail box on the screen. Non-image files are represented by an icon, 
instead of by a small version of an image. Just as you can double-click an image to open 
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a large view of it, you can double-click a non-image file to open it with its corresponding 
program. For example, if you double-click a .doc file, it opens in Microsoft Word.

Note: Your order may contain images from different folders, hard drives, or even computers. In most cases, 
however, it is best to keep all of the images for one order in the same folder.

REMOVING IMAGES FROM AN ORDER
1. To remove an image from an order, click the image to be removed.

2. With the image selected, right-click and select Remove Image or press the Delete key.

You can make many adjustments to the images in an order. For details on editing images, 
see "Products" on page 27.

Example of a non-image 
file in an order along with 
image files.
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ADJUSTING THUMBNAIL SIZE
While entering or reviewing orders, the images in the order are shown as thumbnails. You 
can easily adjust the image size to see more images or larger images.

1. To adjust the size of thumbnail images, click the Thumbnail Size control. This slider 
adjusts the number of thumbnail images in each row. 

2. To view any image as a large image, double-click the thumbnail.

3. To return to the thumbnail view from a large image, double-click the gray background 
area.

Move the slider to adjust the number of thumbnail images in 
each row.
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SORTING IMAGES
1. To change the order in which the thumbnails appear on the screen, open the Tools menu 

and select Arrange Images.

 

2. Select the order you want to use.

RENAMING IMAGES
It is often useful to rename or renumber the images in an order. WorkStream provides a 
method for automatically renaming all of the images in the order using a sequential 
numbering system.

1. Select the image(s) you want to rename or renumber.

2. From the Tools menu, select Rename Images.

3. Enter a prefix, the first number in the new sequence, and a suffix (postfix).

A sample of the new filename appears as you type.
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4. When you are satisfied with the new naming sequence, click OK. The files for all of the 
image thumbnails selected on screen are renamed.

Note: WorkStream does not allow you to rename images once products have been added. The normal time to 
rename images is before you begin to apply print products.

SAVING ORDERS TO THE DATABASE
While you are working on an order, you can click the Save button the toolbar at any time. If 
the order has not been saved previously, you will be prompted to create a new order.

Adding a new customer
If the customer has not yet been added to your database, follow these steps.

1. Click the drop-down arrow beside the Customer field.

2. Select Add Customer.

3. Enter the customer name in the Account Name field.

4. Click OK.

OPENING AN EXISTING ORDER 
Orders saved in the database can be quickly and easily recalled. 

1. Bring up the Orders Bar by choosing File | Open Order
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2. On the Orders Bar, click the Open button.

Once you have selected a customer, the Order drop-down list shows only orders 
belonging to that customer.

3. From the Order Number list, select the order you wish to recall.

4. Press OK. The order appears on the screen.

PRINTING AN ORDER SUMMARY
You can print a summary of your order to a desktop printer. The summary shows a thumbnail 
of each image. You can set the following options:

z Whether or not thumbnails are printed. 
z How many thumbnail images appear in each row (from three to seven)
z Whether or not color correction information appears with each thumbnail
z Whether or not product options (if present) appear with each thumbnail
z Whether or not product notes (if present) appear with each thumbnail
z Whether or not to expand packages.
z Only print thumbnails for Images with Products

1. To check the summary before printing it, select Preview Order Summary from the File 
menu. 
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The summary appears on screen.

2. If you want to adjust the print summary, select Options from the Tools menu. Select the 
Order Summary Settings tab.

3. To change the number of images per row, click the drop-down arrow beside Thumbs per 
row in the Order Summary box. 
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Order summaries may be printed with between three and seven images across.

4. If you made color corrections that you want to display below the thumbnails, check Print 
Color Correction Values. If you do not want to display color corrections in the summary, 
remove the check mark. 

This option is available only if your photo lab permits you to make color corrections.

5. If you have added product options or product notes that you would like to view, check the 
appropriate boxes. 

6. Click OK. 

7. To print the summary from the Preview, click the Print icon at the top of the screen. 
Otherwise, select Print Order Summary from the File menu.

EXPORTING ORDERS
Orders can be exported from WorkStream DS for printing at a photo lab. They can be stored 
in a folder or zip file (for burning to CD), or sent to the photo lab’s FTP server, if provided.

1. To begin exporting, click Print and select your lab’s name. Alternatively, select Export 
Order from the File menu.

2. If the text "Photo Lab (not configured)" appears, you will need to get a configuration file 
from your lab. 

3. If you have not saved your order, you are prompted to do so.

4. The first page of the Export Wizard appears. Enter any notes you would like the lab to 
see here.
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5. Export Options: Select the compression ratio for zip files, whether logos from your logo 
directories will be included, and whether to export images without products.

If the Zipped option is checked, the order will be contained in a zip file and named with 
the customer name and order number as follows: 

WsOrder_customername_ordernumber.zip 

For example: Customer Smith's order number 123 would be exported in a file named 
WsOrder_Smith_123.zip. If the Zipped box wasn’t checked, the order would be exported 
to a folder named WsOrder_Smith_123.

By default, orders exported to disk are placed in the WS_EXPORT folder in your first 
image storage location. (See "Directories and storage locations" on page 104.)

6. Export To: Choose whether to store the exported file on disk, for burning to CD, or to 
your lab’s FTP server.
24 Using WorkStream DS



Orders
When you click Finish, the order is exported in the background. You can keep track of its 
status in WorkStream’s status bar. If you wish to cancel the export, simply click the Export 
button on the Orders bar.

IMPORTING ORDERS
Orders from a photo lab using WorkStream IA can be imported into WorkStream DS. These 
orders are named with the customer name and order number as follows:

WsOrder_customername_ordernumber

They may be zipped. For example, if customer Smith's order number 123 was zipped, it 
would be exported in a file named WsOrder_Smith_123.zip.

Normally, you will place all WorkStream order files to be imported into the WS_IMPORT 
folder in one of your image storage locations. (See "Directories and storage locations" on 
page 104.) 

1. To begin the Import Wizard, select File | Import Order, or simply drop the zip file into 
the Images Panel. 

2. When importing an order, the WorkStream import wizard checks the WS_IMPORT 
folders for orders and displays a list of all orders that can be imported. Alternately, you 
can browse to locate the WorkStream order file.
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3. Enter the customer information as it will be stored in your database.

4. When you click Finish, the order is imported in the background. You can keep track of its 
status in WorkStream’s status bar (located at the bottom of the screen). If you wish to 
cancel the import, simply click the Import button on the Orders bar.
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PRODUCTS 

WHAT IS A PRODUCT? 
A product is a print that you will deliver to your customer. The product may be an individual 
print of a particular size, a unit print in which an image is reproduced multiple times at various 
sizes within the print, or a composite image including graphic components, image files and 
text. Each image in an order may have multiple products. For example, a customer may 
order an 8 x 10 print, a 5 x 7 print, and a print containing eight (8) wallet-sized images. In this 
case, we would say that this image "has three (3) products." Of course, there may also be 
multiple copies of any of the products. Products are selected from the Product Window, 
shown below.

Within the Product window, the products are organized in various groups. You may arrange 
the products in groups to suit your needs. As shown here, there are seven groups of products 
labeled Common, Logos, Other, Standard Sizes, Templates, and Units. 

Your products may be organized differently.

ORGANIZING PRODUCTS
Products in WorkStream are contained in files stored under the Products folder. By default, 
the Products folder is located in the same folder as the WorkStream program. 

Product Groups
Products are organized in seven tabs: Index, Logos, Packages, Proofs, Std Sizes, 
Templates, and Units.
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The folders inside the Products folder mirror the product tabs in the Products window. For 
each tab, there is a folder.

The actual product files are in the appropriate folder. To rearrange the products in the product 
view, see "Arranging Your Products" on page 29. 

Adding and Removing Product Tabs
To add or remove product tabs, use the Product Window settings tab in Tools | Options.

Viewing Tabs
Sometimes it is not possible to view all of the tabs in the Products Window at once. By using 
the scroll buttons at the bottom of the Products Window, you can change which tabs are 
displayed.

Click the Scroll Buttons to 
view more tabs.
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1. From the Tools menu, select Options, then Product Window.

\

2. In the check list, you may add or remove product tabs using the buttons. 

3. All the checked items will be shown.

4. To hide a tab without deleting it, simply un-check the box next to it. This can be useful for 
tabs such as the proofs tab. Once you have set up your proof products, you may wish to 
hide the tab containing them.

Arranging Your Products
You can create new products in these folders (tabs) as described in "The Product Builder: 
Creating a New Product" on page 40. You can also move your products from tab to tab, 
simply using drag-and-drop:

1. Click on the product you wish to move, and hold the mouse button down.

2. If you wish to copy the product into the new tab, hold down the Control key.

3. Drag the product onto the new tab, then drop it into the window.

In some cases, you may want to move products in and out of subfolders in a tab. In this case, 
you may need to Cut and Paste the products. On the right-click menu, select Cut Product, 
then navigate to the folder you want to move the product to, then right-click on the empty 
portion of the product tab and select Paste Product. 

Add a new tab.

Remove the selected 
tab.
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Sorting Your Products
If you wish to alter the order in which your products are shown in any product tab, you may 
right click in the product window for the desired tab, and select Sort By.

PRODUCT TYPES
Products are created and edited using the Product Builder. (See "The Product Builder: 
Creating a New Product" on page 40). 

Proofs
Proof products are for proofing purposes. They are created just like any other product, using 
the Product Builder. However, proof products must be saved to the Proofs tab. You may see 
proofs of the images in your order as follows:

1. Select the images you want to proof.

2. From the File menu, click Print Proofs. The Proof dialog appears.

3. Select the proof size you would like from the drop-down.

4. Press OK.
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Custom
Custom products consist of one or more prints with a defined layout. Examples of Custom 
products are: Standard Sizes, Units, and Templates. Custom products can have both fixed 
and dynamic images, logos, and text. 

Any product that holds two or more distinct images is considered a template. For more about 
templates, see "Using Photoshop to Create Alpha Channel Templates for WorkStream" on 
page 32, "Creating your template in WorkStream" on page 36, "Editing your template in 
WorkStream" on page 36, "The Automatic Template Converter" on page 37, and "Using 
Templates" on page 38.

Scaled
Scaled products allow you to print images sized relative to the resolution of the image. If the 
selected scale is 100%, the image will be printed at the largest size possible without 
interpolation on the selected printer. If the selected scale is 50% the image will be printed at 
50% of its full size on the selected printer. Since different printers may print at different 
resolutions, an image sized at 100% may print at different sizes on different printers.

Package
Packages are combinations of other products. They may consist of custom products and 
other package products. 

Non Photo
These products are items that don’t print (e.g. Mugs, Buttons, etc.).

Index Print Sheet
Index Print Sheets are special products that you can add to your order to get an index print 
with all your images in it. The images will be added to the index print in their current 
orientation, so orient them appropriately on screen before applying the index print. Additional 
pages are automatically added when each sheet fills up. 
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MODIFYING PRODUCTS
If you find that you are usually changing some of the product's settings after you select it, you 
can modify a product's settings. 

1. Switch to the Product Builder view.

2. Click Open to edit an existing product. 

3. See "The Product Builder: Creating a New Product" on page 40 for details on using the 
Product Builder.

4. Save your changes. See "Saving Products" on page 48 for details on saving.

LOGOS
Logos, although they are listed in a tab along with products, are NOT products. A product 
must be added to an image before a logo can be applied. Logos are created with your image 
editor (e.g. PhotoShop), and added to WorkStream by right-clicking in the Logos tab and 
selecting Add Logos. 

Any of the following file types can be used as a logo:
z 24-bit RGB bitmaps (.bmp) 
z JPEG images (.jpg)
z RGB TIFF images (.tiff). Note that Version 5.0+ of Chromira Printer, version 2.1+ of 

WorkStream RE, and version 2.1+ of WorkStream support alpha channels and LZW 
compression for TIFF images.

Using TIFF images and the software versions specified above, you can use an alpha channel 
to specify transparency. Otherwise, simply fill the top left corner and the entire background of 
the logo with one solid color. 

Note: Be careful with tolerance and anti-aliasing when working on a logo in Photoshop. When you add text or 
paint the background, Photoshop will blend them together or create a shadowing effect. This may lead 
to a poor print. Make sure that the edges between the foreground (visible) and the background (which 
will be transparent in WorkStream) are sharp, and that the background color consists of a single RGB 
value. This will ensure the best printed results.

USING PHOTOSHOP TO CREATE ALPHA CHANNEL TEMPLATES FOR 
WORKSTREAM

What is an Alpha Channel?
Typical RGB images consist of three color separations (or channels) which describe how 
much Red, Green, or Blue light to blend together to produce a color image. An Alpha channel 
is an optional fourth channel that dictates areas of transparency in an image. When a 
document that includes an Alpha channel is opened in certain programs (such as 
WorkStream), the Alpha channel tells the program which parts of the image to display and 
which parts to make invisible. Alpha Channels are black and white images with 256 degrees 
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of transparency-- white (255,255,255) is perfectly opaque, 50% gray (128,128,128) is 
halfway visible, and black (0,0,0) won't display at all.

How does WorkStream use Alpha channels?
WorkStream uses Alpha channels to make certain areas of a template transparent, allowing 
the user to place dynamic images into custom frames, sports packages or albums. Below are 
directions for creating a custom Alpha channel in Photoshop. If you do not use Photoshop, 
there are many other graphics programs that support Alpha channel creation. 

A Simple Example
In this example, we'll make a simple vignette-type template. Remember that you can use 
Alpha channels to make multiple "holes" in your template, place text over an image (for a 
magazine cover effect),  drop shadows onto dynamic images, and much more.

1. In Photoshop, create an 8x10 RGB image at 300dpi (make sure that it's set to the default 
8 bit mode by choosing Image | Mode | 8bits/channel). This is the image that will work 
as the background for your template.
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2. Pick the Elliptical Marquee Tool from the toolbar and draw a selection where you'd like 
the "hole" to appear. 

3. Feather your selection to create a nice blend by choosing Select | Feather... Enter a 
value of 150 pixels to feather the selection half an inch and hit OK.

4. Choose Window | Channels to bring up the Channels palette. Click the "Save selection 
as channel" button on the bottom of the palette (it looks like a small gray square with a 
34 Using WorkStream DS



Products
white circle in the middle). This will create a channel called Alpha1. NOTE: you may only 
use one alpha channel. 

5. Make sure that your ellipse is black. If it isn’t, you will have to invert the alpha channel. To 
do this, make sure only the alpha channel is visible, then use Select | All and then use 
Image | Adjust | Invert (Ctrl-I).

6. Choose File |Save As...  and select TIFF from the pull down menu. Make sure the 
"Alpha Channels" box is checked. Select LZW Compression if you wish.

7. You are now ready to create your template in WorkStream

Step 4: Press the "Save 
Selection As Channel" button

Step 5: Make sure your ellipse 
is black.
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CREATING YOUR TEMPLATE IN WORKSTREAM
Use the Automatic Template Converter to quickly and easily prepare your template for use 
in WorkStream.

1. From the Tools menu, select Automatic Template Converter. 
2. Browse for your image file.

3. Select the tab you would like to the template to appear in.

4. If your alpha channel contains a gradient, you will need to select a transparency 
tolerance. For the example above, 200 is a good value.

5. Press Run.

For more detailed instructions on using the Automatic Template Converter see "The 
Automatic Template Converter" on page 37. 
Once the automatic template converter is finished, inspect the results. If your image contains 
a gradient, or you specified a transparency tolerance above, this is especially important. See 
"Editing your template in WorkStream" on page 36, below.

EDITING YOUR TEMPLATE IN WORKSTREAM
Open the Product Builder by selecting View | Product Builder | Switch To. 

1. Open the template you would like to edit. You may use the Open button, or find your 
product in the products tab, right click it and select Edit Product.

2. Make sure that all the holes in the template are positioned correctly. Each hole will be 
marked with "Image 1", "Image 2", and so on. To reposition one of the holes, you may 
drag it and resize it. 

3. Sometimes it is hard to drag or resize the holes because they are behind the template 
image. If this is the case, you may decide to drag that hole to the top of the Contents 
Bar. It will then be easy to resize and reposition. Be sure to drag the hole back to its 
previous position in the contents bar before continuing. Failure to do so will cause 
your template to display and print incorrectly. 

4. If you wish to change the aspect ratio of one of the holes, click the Lock/Unlock button 
on the Components Bar. When the lock is open, you will be able to resize the hole in 
any dimension you specify.

5. When you have finished modifying the template, click Save. You will be asked if you want 
to overwrite the current product. Click Yes to save your changes. 

You are now ready to use your template in WorkStream. When you add your new product to 
a WorkStream order, any images you drop in will show through the correct portions of your 
template. 
36 Using WorkStream DS



Products
THE AUTOMATIC TEMPLATE CONVERTER
The Automatic Template Converter (Tools | Automatic Template Converter) allows you to 
use BMP, TIFF, or JPG templates with WorkStream. Do not embed profiles in your templates 
if you are using a transparency color. 

z Transparency - If you’ve used alpha channels to create a transparency mask for your 
template, check this option. Otherwise, select your template’s transparency color.

z Tolerance: 
If you have selected "Use Alpha Channel": The Template Maker will apply this 
tolerance to the image’s alpha channel. "Holes" in the image will be found only within 
alpha values between 0 (transparent) and the value you have entered. This is useful if 
your alpha channel contains gradients or fade effects. 

If you have selected "Use Transparency Color": When finding the transparency color 
in an image, the Template Maker will apply this tolerance to each channel of an RGB 
image. For example, if the transparency color is Gray (128,128,128) and the tolerance is 
2, any color between (126,126,126) and (130,130,130) will be transparent. This feature 
is best used on JPEG images, to compensate for compression artifacts. For non-JPEG 
images, best results will occur when tolerance is set to 0 and pure colors are used in the 
template image.

Template List - 
All the image 
files to be 
processed are 
listed here.
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z Print Oversize - All holes detected by the Template Maker will be increased in size by 
this number of pixels in each direction.

z Print Template - If checked, the template image will be part of the print. Otherwise it 
will be used to position the images holes, but the template image will not be printed.

z Write Product(s) To Tab: Select the product tab you wish the template to appear in. 

USING TEMPLATES
Any product containing multiple image names is considered a template. Unlike other 
products, Templates are not applied to images. Instead, a template is added to an order. It 
appears in the thumb view and images are dragged into it.

There are several rules that govern how a template works when multiple images are dropped 
into it:

If the template is empty:
z and the number of images dropped into it is less than or equal to the number of 

uniquely named prints, each image will be dropped into a print.
z and the number of images dropped into it is greater than the number of uniquely 

named prints, all the images that fit will be dropped into the template. Enough copies 
of the template will be opened to store the remaining images, and they will be dropped 
into the copies.

If the template is not empty, the functionality is as above, with the exception that the images 
currently in the template get copied along with the template. See the example below.

6 Images (blue borders) are 
dragged into a template. Its border 
turns magenta to indicate that the 
selected images will be dropped into 
it. 
38 Using WorkStream DS



Products
On the left, the team image has 
already been placed in the template 
and cropped. The six players will 
now be dragged into the remaining 
empty slot.

On the right, after the player 
images were dropped in the 
single template, templates have 
been created for each team 
member, automatically 
preserving the team picture in 
each template.
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THE PRODUCT BUILDER: CREATING A NEW PRODUCT
WorkStream’s powerful product builder allows you to create new print products quickly.

1. To create a new product, go to the View menu, select Product Builder, and click Switch 
To.

The Product Builder View appears:

2. On the Product Builder Bar, click the New button to create a new product.

Product Builder Bar
Open, save and create products 
here.

Lab Controls Bar
Adjust printing details here.

Products Bar
All your products are stored here. Drag 
them into the contents bar or directly 
onto the Product Canvas.

Contents Bar
Shows the print components, from 
topmost to bottom. Change their order 
here. The product name and description is 
displayed on the first line here.

Product Builder Toolbar
Add, remove, rotate, and crop print components.

Product Canvas
Arrange the layout of your custom 
product’s print components here.
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3. On the Product Type page, you will be prompted to select the type of product you wish 
to create.

z Custom Product
z Scaled Product
z Package
z Non Photo Product
z Index Print Sheet

See "Product Types" on page 30 for more information about the different types of 
products.

4. Click Next.
5. Enter a Name and optional Description for the product you wish to create. If you are 

creating a Custom Product, you will also enter the Width and Height of the product you 
wish to create. If you are creating a Scaled Product, you will enter the Scale Percentage 
instead of Width and Height.

6. Click Finish.

z If you are creating a Non Photo product, you will be prompted to save. See "Saving 
Products" on page 48.

z If you are creating a Scaled product, you may adjust its properties ("Removing 
Products" on page 49) before saving it.

z If you are creating an Index Print Sheet, you will be prompted to enter its properties.
z Otherwise, WorkStream will display your blank canvas and show the name and 

description of the product you created. See "Switch to the Product Builder view." on 
page 32 for a detailed explanation of this screen.

ADDING COMPONENTS TO YOUR PRODUCT
Once you have created your product, it is time to add components to it. 

Names
Each component of a product has a name. With static components, the component name is 
the filename of the image or logo, or the text to display for text components. For dynamic 
components, names are simply placeholders. For example, if several image components in a 
product have the same name (e.g. Image 1), they will all be populated with the same image 
during order entry. 

Custom Products
There are 4 different components types that can be added to a new Custom Product: Prints, 
Images, Logos, and Text.
Using WorkStream DS 41



Prints 
Any other custom product can be added. The following cannot be added:

z Packages
z "Unit" products created with older versions of WorkStream. 
z Non Photo products

To add a print to your custom product, select the print in the Product View and drag it either 
onto the Product Canvas or into the Contents Bar. Dragging the print into the Contents Bar 
will position the print at the upper left hand corner of the canvas. You may wish to drag it onto 
the canvas; with this option the print will be positioned where you drop it. When a print is 
added, its components become ungrouped, and must be repositioned separately. After the 
print is added to the product, you may change its name. See "Names" on page 41.

Images, Logos and Text
To add Images, Logos, or Text use the Add Component button.

Choose which type of component you would like to add. 
z Image
z Logo
z Text

On the next page, you will be prompted to select whether this is a fixed or static component, 
specified now, or a dynamic component, which will be specified when the product is added 
to an order. All dynamic components have names associated with them. See "Names" on 
page 41.

Images:
z Fixed: Browse for an image which will become part of the product. This option is 

useful for creating Templates. (You can also make templates using the Automatic 
Template Converter). You will probably want to select a transparency color if you are 
using a fixed image for a template.

z Dynamic: Select a name for the dynamic image here. The name will show up in the 
Contents Bar. The dynamic image will be supplied when the order is created. See 
"Names" on page 41 to understand how the print’s name is used.
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Logos:

You can create your own logos for use in WorkStream. For information about creating 
logos, see "Logos" on page 32. The Component Settings for a logo are the same as for 
a text component, shown below.
z Fixed: Specify a logo to use with this product. You will probably want to select a 

transparency color if you select this option. In order for the logo to appear in the 
desired location, the image must be oriented correctly before the product is applied.

Text:
z Fixed: Supply the text in the Fixed Text box and select the font and text color, as well 

as any appearance options you desire. adjusting the width will update the height, and 
vice versa. The text cannot be sized to be larger than the canvas.

z Dynamic: With the dynamic text setting, you have all the control over font settings that 
you do with fixed text. However, dynamic text can be populated with image and order 
dependent information or external data, as shown below. For more on External Data, 
see "Dynamic Text: Using Text from an External Database" on page 44
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On the next page, set the text size by adjusting the width or the height. 

Because some of these settings are image-dependent, when using dynamic text, you 
need to select an image that the text will be associated with in the Add To drop-down. 
For example, the File Path, File Name, and File Size options are all image-dependent. 
The Location drop-down allows you to automatically position the text at any of the 
images corners or sides.

Packages
If you are creating a Package, you can use any other photo product as a component. Simply 
drag the product you want to add to the package into the contents list. If you wish to remove 
a product, simply select it in the contents bar and press delete, or right click on it and select 
Remove Component.

DYNAMIC TEXT: USING TEXT FROM AN EXTERNAL DATABASE
In the Add Component Wizard (page 42), we saw how to add different kinds of text 
components to your product. External Data is a special kind of dynamic text. It allows you to 
set up text components when you are creating a product that can be populated from a text 
file when you are adding the product to images. Common uses of external data include 
Trader Cards. Let’s see how to use it.

Setting up the text component
1. In Product Builder, open a product, or create a new one that you would like to use 

dynamic text with.

2. In the Add Component Wizard, add a new Text Component and click Next.
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3. On the next page, choose Dynamic Text and select External Data from the menu.

4. You will be prompted to name the data field. Enter a descriptive name that will make 
sense to you when using the product later.

5. Click OK. A new tag will be created in the Dynamic text box. In the example above, the 
tag looks like this: [data_Player Name]. You can type additional text into the edit field 
here if you want, but don’t alter the text between the brackets.

6. Continue through the wizard as usual, and place the text component where you will use 
it. 

7. Save your product. Once you have a text file to draw data from, you will be ready to use 
the product in an order.
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The data file
External data is pulled from a file that you will specify when adding your product to an image. 
This file must be in a special format called Comma Separated Values (.CSV). Microsoft 
Excel can generate this type of file. In Excel (or a similar program), create a file that has a 
column for each text field you want to use. It is helpful to make a row of headers, which 
describe the data below. In the example below, File Name and Player Name are the 
headers.

In this example, the header row 
contains File Name and Player 
Name
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File Names
In the example above, the first column contains a list of file names. When placed in the first 
column, the file names allow you to specify which text is associated with each image. When 
you add the product to an order, the text will be added to the corresponding image, specified 
in the first column.

Adding Products with External Data to your order
When you first double-click on a product to add it to an order, the External Text Wizard will 
appear.

1. On the first page, you will be prompted to browse for a .csv file that contains the external 
text.

2. On the second page, you will be shown the first few rows of the text file, and prompted to 
check if headers are present.
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3. Finally, you will be asked to assign text mappings. The mappings associate each column 
in the .csv file with a text component in the product you’ve created.

SAVING PRODUCTS
When you have finished setting up your product, you may save it in one of two ways:

z Select Save. If you have opened an existing product, this will overwrite your existing 
product’s settings. If you have created a new product, you will be prompted to select a 
tab to save into: 

z Select Save As. This allows you to save the product with a new name. The original 
product that you opened will not be modified.

In this example, there is only 
one text field, [data_Player 
Name]. 

In the second column, we 
have three choices: either of 
the two columns from our csv 
file (shown above), or blank. If 
you choose blank, the text 
field will not be mapped at all. 

In this case, our named 
columns make it easy to see 
we should select Column 2 
("Player Name").
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DELETING PRODUCTS
You can easily remove any products that you do not use.

1. Right-click on the product that you want to delete.

2. From the menu, select Remove Product.

REMOVING PRODUCTS
Select the products you wish to remove. Then, either:

z Press Control-Delete.
z Right-click and select Selected Products | Remove Selected. This option will only be 

available if you have two or more products selected at a time.

SELECTING PRODUCTS
You may select individual products, either singly or multiply, in order to modify their settings, 
or remove them from images.

1. In the thumb view, click on a product you wish to select.

2. Hold down the Control key to select additional products.
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3. Select additional products.

4. The products you have selected are highlighted in green.

In the Large Image view, you may set the active product using the Products Tree bar. 

THE PRODUCTS TREE
The Product Tree lists all of the products applied to a given image. It allows you to expand 
the contents of packages to view their contents, and also, combined with the Contents Bar, 
allows you to edit settings for each of the components in your product.

MULTI-SELECT PRODUCT CHANGES
Once you have selected multiple products, you can make changes to all of them, just as you 
would to a single product. The controls will be grayed out, but clicking them will allow you to 
edit them. The changes get applied when images or products get deselected, or when you 
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choose to print, save or export. This can be especially handy for applying color changes to a 
batch of images.

You may also remove the selected products using the right-click menu or the Control-Delete 
keystroke.

CHANGING A PRODUCT
Once you have added a product to an image, you can freely change any or all of the 
characteristics of the product. For example, you can change the number of prints, the print 
size (in some cases), and the material type. The changes that you make apply to this print 
only. To make permanent changes to a product, see "Modifying products" on page 32.

Clicking the Qty field enables you to change the quantity for the 
selected products.
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Adding Components
In addition, you can add, remove, and crop components with the following buttons:

z Add - allows you to add components to the current print.
z Remove - removes the selected component.
z Rotate - rotates the selected component when the product is unlocked.
z Crop - takes you in and out of the cropping view of the selected image.
z R. Crop - rotates the crop of the selected component.
z Reset - sets the crop to a maximized center crop in the crop’s current orientation.
z Lock - this button is explained in "The Cropping and Product Locks" on page 53. 

Moving Components
You can move components in a product by unlocking the product, then dragging the desired 
components around on screen. Alternatively, you can change the top left position of any 
component in the Contents Bar.

Setting print size, borders, and quantity
Use the Basic Settings Bar to control the final printed image(s).

1. Click to select the product(s).

2. In the Basic Settings Bar, make adjustments to the width, height, and size of the print.

3. In the Borders area, you may set or modify the borders around the print(s).

4. You may also change Paper Type, Print Type (Color or Black & White), or Quantity.
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The Cropping and Product Locks
There are two lock buttons in WorkStream. The lock button on the Print Size Settings bar is 
the Product Lock.

z Locked: the aspect ratio is locked for all components of the selected product. 
z Unlocked, you may resize the image

The lock button on the Product Builder Toolbar is the Component Lock. 
z Locked: the aspect ratio is locked for the selected component.
z Unlocked: the aspect ratio of the crop may be changed in the cropping view, and the 

image may be resized in the large image view.
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IMAGES IN AN ORDER

WorkStream DS provides many tools to help you work with images. You can use these tools 
on thumbnail images or on full-screen large images. 

ADDING AND REMOVING IMAGES FROM AN ORDER 
To Add or Remove images from an order, see "Adding images to an order" on page 16 or 
"Removing images from an order" on page 17

FLOATING AN IMAGE
You can "float" any of the images in an order. When you float an image, the image is opened 
in a separate window to be used as a reference. You can move or resize the window to suit 
your preference. A floated image provides a good consistent reference that you can use for 
comparison to the other images in the order. 

1. To open any image as a floating image, click the image to select it. Right-click to open 
the drop-down menu and select Float Image. Alternatively, use the ’F’ hotkey.

2. To adjust the size of the floating image, drag on any corner. 

Show without Color Correction: Click and 
hold this button to display the floating image 
with its original colors. Release the button to 
display the image with color corrections you 
have made.

Click this button to toggle between these two 
settings:

Freeze Color Corrections: Make color 
corrections on the main image without 
changing the floating image.

Lock Color Corrections to Main Image: 
Change the floating image to match the 
corrections you made on the main image.

These settings show the color corrections you 
have made in the Color Correction panel:
D = Density
C = Cyan
M = Magenta
Y = Yellow
Ct = Contrast
S = Saturation
Sh = Sharpen
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Images in an Order
SCRATCHING AN IMAGE
To allow images to remain part of an order, but to indicate that you do not plan to print them, 
it may be useful to scratch them. Using Scratch Image on the right-click menu in the 
thumbnail view, you may place a red X over the selected images. You may also use the ’X’ 
hotkey.

Once you have scratched an image, products will no longer be added to it. 

To unscratch images:

1. Select the desired image(s).

2. Right-click on one of the images in the selection.

3. Select Unscratch Image.

Alternatively, you may use the X or Shift-X keystroke on the selected image.

You may purge scratched images at any time in one of two ways:
z Right click on any image in the thumbnail view, and select Purge Scratched Images.
z Select Purge Scratched Images from the Tools menu.

You may also sort your images by scratched status. Go to Tools | Arrange Images | By 
Scratched Status.
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ADJUSTING COLOR
Use the Color Correction panel to make very precise color adjustments to one or more 
images.

1. Click to select the image(s).

2. In the Color Correction panel (Select Color Corrections from the Windows menu), click 
the arrows to adjust color, density, saturation, sharpness, and contrast. 

Alternatively, you may use the Color Correction Slider bar, which is accessible by clicking 
on the color corrections listing at the bottom of the thumbnail view:

3. To temporarily hide the corrections you have made in order to view the original image, 
you may use the ’K’ hotkey to toggle the corrections on and off.

Floating Images and Color Corrections
1. To adjust the color of the floating image, click the up or down arrows in the color 

correction bar. The floating image changes to show your corrections. The settings are 
displayed above the floating image.

2. To compare your color corrections with the original image, click and hold the first button 
above the floating image. The floating image is displayed with its original color settings. 
When you release the button, the floating image appears with the corrections you have 
made. (see "Floating an image" on page 54 for more about floating images)

Click in this area to view the Color Correction Slider bar and make 
color corrections.
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Images in an Order
3. Click the second button above the floating image to toggle between the following 
settings:

ROTATING IMAGES
1. To rotate an image, select it by clicking on the thumbnail.

You can rotate multiple images at the same time by selecting all of the images you wish 
to rotate. 

2. With the image(s) selected, right-click and select Rotate | Rotate CW (clockwise), 
Rotate | Rotate CCW (counter clockwise), or Rotate | Flip (180). 

Freeze Color Corrections Make color corrections on the main image without 
changing the floating image. This setting makes it easy 
to compare the two images.

Lock Color Corrections
to Main Image

Change the floating image to match the corrections you 
have made on the main image.
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ARBITRARY ROTATION
When you are in Cropping Mode, you may rotate an image any number of degrees. This can 
be useful for straightening images, or just to present your image in a different way. Without 
products applied, you can simply double-click an image, and begin to rotate it. There are 
three ways to rotate your image.

Rotation via Menu
By pressing Ctrl-A, or selecting Rotate|Arbitrary from the right-click menu, you can bring up 
the Arbitrary Rotation menu.
58 Using WorkStream DS



Images in an Order
This menu allows you to directly enter a number of degrees, clockwise (CW) or counter-
clockwise (CCW) to rotate the image.

Rotation via Aligning to line
Alternatively, while the Arbitrary Rotation menu is shown, you can select two points on the 
image, drawing a line between them, and rotate the image so that the line you have chosen 
is straight.

Drawing a line between 
the model’s eyes allows 
us to straighten the 
head in this image. 

We could just as easily 
have used this feature 
to straighten a crooked 
scan by finding a line 
that should be straight, 
and tracing over it.
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After the rotation has been applied, the image looks like this:

Note that the crop has 
been adjusted to stay 
within the bounds of the 
image.
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Rotation via Dragging
It is also possible to click on any corner of the image, and rotate by dragging. The cursor will 
change to the rotate cursor (shown in the screen below).

APPLYING DEFAULT CROPS
Often times you will want to apply the same crop to all images on a product. This is possible 
using the Match All Crops feature (page 63). However, it is easier to go through an order 
and crop the images first. When products are added later, they will use the default crop you 
have established.

To apply a default crop:

1. Double-click on a thumbnail. This will take you to the large image view. 

2. Notice that there is a fine red line around the image. This is the crop. Position your cursor 
over it.

3. Notice that your cursor changes to a double-headed arrow. When this happens, you can 
click and drag the crop. This will resize the crop.

The cursor has 
changed to the 
rotate cursor.

Notice that 
although the image 
doesn’t move while 
you are dragging it, 
the red crop outline 
does.
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4. To move the crop, move your cursor inside the crop, so it is positioned above the image. 
It will change to a four-headed arrow. You may now reposition the image by clicking and 
dragging.

5. To change the crop aspect ratio, unlock the crop, using the large lock button. You may 
then continue to resize and reposition the crop. When you are finished, lock the crop. 
You may also rotate the image at this point, using any of the methods described in 
"Arbitrary Rotation" on page 58.

ADJUSTING COLOR
Use the Color Correction panel to make very precise color adjustments to one or more 
images. You can adjust colors either in thumbnail view or in large image view. However, this 
capability is available only if your photo lab permits you to make color adjustments.

1. Click to select the image(s).

2. In the Color Correction panel (Windows | Color Corrections), click the arrows to adjust 
color, density, saturation, sharpness, and contrast. 

Alternately, you may use a ZBE Color-Pro II. 

CROPPING
Each product added to an image may be individually cropped. In some cases the print size 
may not match the shape of the image file and the image will be automatically cropped by 
WorkStream. In either case, you can adjust the crop to your preference. 

You may crop from the large image view by holding down the control key and dragging the 
image around until you are happy with its position inside of the crop rectangle. Release the 
control key when you are done. However, the following procedure will give you more control 
over the cropping:

1. Double-click the image you want to crop to open a larger view of it.

2. Load the product you wish to crop by double clicking on the desired product in the 
Products Tree, then double-clicking on the image.

Time-Saver: As an alternative to step two, you may hover the mouse over the crop outline for the product you 
wish to crop in the thumb view. When the cursor changes to an arrow, simply double-click, and you will 
be taken to the cropping view.
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Images in an Order
3. Grab the crop outline and drag it to the size you want. 

4. To move the crop, click inside of the cropping rectangle and drag the crop to position it.

View All Crops
The View All Crops feature shows a dotted line for each of the crops in the thumbnail view. 
To activate this feature, go to Tools | Options | Display Settings and check Show All 
Crops. 

When the image name is selected, all crops will be shown. When single product names are 
selected, only the portion of the image contained inside the product’s crop will be shown.

Copying Crops
A crop can now be copied from any non-template product on any image in an order and 
pasted to all other non-template products in the order.  With a single product selected, press 
Shift+C to copy the crop.  With any number of products selected on any number of images, 
press Shift+V to paste the crop.  Right click menu options are available for this as well.

Match all Crops
Match All Crops allows you to crop one product just the way you like it, and then apply it to all 
other products on the current image. You must be in the Large Image View or the Cropping 

An image with 4 products is 
shown in the thumbnail view 
with 4 dramatically different 
crops.

Selecting the Image name 
will show all crops on the 
current image.

Each of the 4 crop boxes:

5x7

2x3

3x5

4x5

Selecting a single product will 
show only the portion of the 
image contained inside its 
crop.
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View to use Match All Crops. Once you are done cropping the image, right-click and select 
Match All Crops to This One. To see the results, you can use the View All Crops 
functionality, documented above.

CREATING A B&W PRINT
In some cases, you may choose a black and white print. Use the Color Correction panel to 
change an image to black and white.

1. Click to select the image(s).

2. In the Color Correction panel, open the Print Type drop-down list. Select Black & White.
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Images in an Order
3. An indicator will appear next to the product, showing that it will be printed in Black & 
White.

SHARPENING AN IMAGE
Use the controls on the Color Correction panel to sharpen an image.

1. Click to select the image(s).

2. In the Color Correction panel, click the arrows under Sharpen.

VIEWING A SLIDESHOW
To view a slideshow containing all of the images in your order, use the Presentation button.
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To modify your slideshow settings, click the Tools menu, and select Options. In the 
Slideshow Options page, you will be able to adjust the following settings:

z Show one slide for each image: If unchecked, a slide will be shown for each product 
on an image. One slide will be shown for images without product. If checked, each 
image will be shown only once, regardless of the products applied to it.

z Seconds between slides: Adjust this option to alter the timing of your slideshow.
z Continuous Loop: This option causes the slideshow to continue playing until the Exit 

button is clicked. Otherwise, the slideshow exits after all the slides have been shown.
z Start Paused: If this option is checked, pressing the slideshow button will switch to 

the slideshow view, but will not begin until you press the start button.
z Full Sized Images: This option maximizes the images on the screen.
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Screen Views and Layouts
SCREEN VIEWS AND LAYOUTS

WorkStream DS provides different screen views for different functions or uses. In addition to 
the three views that are automatically installed with WorkStream DS, you can create your 
own views with the specific components you want to see.

USING THE DEFAULT VIEWS
Five standard views are provided in WorkStream DS. You can quickly rotate between these 
views as you work by clicking the View button in the toolbar. 

Customers 
In Customers View, the top panel shows information on your customers and the orders they 
have placed. The lower panel shows the current order.
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DS View
DS View contains products, settings for products, and color correction controls (if permitted 
by your photo lab) that you can apply to the images in the main panel. 
68 Using WorkStream DS



Screen Views and Layouts
Folder View
In Folder View, the file structure on your computer appears in the left panel. This view allows 
you to preview or load the contents of an entire folder onto the main panel. Clicking on any 
folder clears the screen and loads previews of its contents.
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Presentation 
The presentation view is used for slideshows. Clicking the eject button (top) at the far left will 
return you to WorkStream DS.

Product Builder
The product builder view is used for creating and modifying your products. It is fully 
documented in "The Product Builder: Creating a New Product" on page 40.

SWITCHING VIEWS
1. To change to an alternate view, click the View button on the toolbar. 

The view switches to the next one on the Rotation list. 

2. Click the View button again to switch to the next view on the list. 

To add or remove one or more views, see "Changing the rotation of views" on page 74.
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3. To switch directly to a specific view, select the view you want to use from the View menu. 
From the submenu, select Switch To.

CREATING A NEW VIEW
The views in WorkStream can be changed to suit your individual needs or preferences. Using 
the Create View option, you can create a new view and arrange the windows and controls 
into any layout you like. 

Tip: In most cases, the easiest way to create a new view is to copy and modify an existing view, rather than 
starting from scratch with a new view. See "Copying a view" on page 74.

1. To create a new view, select Create a new View from the View menu.

2. In the New View dialog box, enter a name for your view and click OK.

An empty view, with no controls, appears.

3. From the Windows menu, select any of the controls you want to have on that view.

Color Corrections

Images Bar
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Button Bars

Panels

ICC Bar

Order Lookup

Basic Settings Bar

Orders Bar

Image Bar

Feature Bar

Navigation Bar

Products All the available print products you can apply to an image.

Data Customer and order data.

Folder Tree Directory structure of your computer.
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LOCKING A VIEW
After creating your new view, it is best to lock 
it. Locking a view prevents the controls or 
windows from being inadvertently moved 
while using WorkStream. 

1. From the View menu, select the name of 
your new view. (Custom views are listed 
at the bottom of the menu.)

2. From the submenu, select Lock.

DELETING A VIEW
You can delete any of the views that you 
have created. Be aware, however, that 
once you delete your view, it is gone. You 
cannot un-delete it.

You cannot delete any of the default 
views provided by WorkStream 
(Customers, DS View, Folder View, 
Presentation, Product Builder). If you 
wish, you can remove any view from the 
view rotation. (See "Changing the rotation 
of views" on page 74.)

1. From the View menu, select the view 
you want to delete. (Views you have 
created are listed at the bottom of the 
View menu.)

2. From the submenu, select Delete.

3. In the Warning dialog box, click Yes to delete the view.

Important: Remember that once you delete the view, it cannot be recovered.
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CHANGING THE ROTATION OF VIEWS
Clicking the View button on the toolbar 
changes the view to the next one on the 
rotation list.If you do not want a particular 
view to be opened with the View button, 
you can remove that view from the 
rotation list. 

This action does not delete the view; it 
only removes it from the views that you 
see when you click the View button. You 
can still open this view by selecting it 
directly from the View menu.

1. From the View menu, select the 
name of the view you want to 
remove.

2. From the submenu, select Remove from Rotation.

COPYING A VIEW
In most cases, the best way to create a 
new view is to copy an existing view, and 
then modify it to suit your needs.

1. From the View menu, select the view 
you want to copy. From the 
submenu, select Copy.

2. In the New View dialog box, enter a 
name for your view and click OK.

3. Use the Windows menu to select 
options to add or remove from your 
new view. Move panels around on 
the screen to suit your needs.

4. When you have finished, select your view from the View menu. From the submenu, 
select Lock.
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Reference Images
REFERENCE IMAGES

Reference images provide a visual reference for color comparison. They open in a separate 
window which you can compare to the images in your order. WorkStream includes three 
reference images: Genny, Laura, and Melody. 

You can have up to fifteen reference images. You can open any or all of them at any time on 
screen. One of the reference images is designated as the master reference image; it is the 
image that opens when you click the REF IMG button. You can set any of your reference 
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images to be the master reference using the menu arrow beside the REF IMG button on the 
toolbar.

OPENING A REFERENCE IMAGE
1. To open the master reference image, click the REF IMG button on the toolbar.

2. To open one of the other reference images, click the arrow next to the REF IMG button. 
Scroll to the image you want to open and select View.

COLOR CORRECTING REFERENCE IMAGES
In addition to viewing reference images, you can also apply color corrections to them, if your 
lab allows.

1. Right click the floating reference image, and select Edit Color Corrections.

Click the REF IMG icon to see the master 
reference image.

Click the arrow to the right of the icon to select 
other reference images or to set a new image as 
the master reference image.
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Reference Images
2. The Profile Settings and Color Correction Bar will pop up and become enabled.

3. Make any desired changes to the corrections.

4. To save the corrections you have made, simply close the floating reference image 
window. You will then be prompted to save. Alternatively, you can right click on the image 
and select Save Color Corrections.

5. To discard them, manually reset the corrections to where they were when you began 
making corrections. 

ADDING A NEW REFERENCE IMAGE
In addition to the reference images provided with WorkStream, you can add your own 
images. There are two ways to select a new image.

Adding an image by browsing
1. To add a reference image, click the arrow next to the REF IMG button.
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2. Select Browse for Reference Image.

3. Navigate to the image you want to add and click Open.

Adding an image currently open on screen
Alternately, you can add one of the images open on screen in your current order as a 
reference image.

1. With an order open on screen, click the image you want to use.

2. With the image selected, click the arrow next to the REF-IMG button.

3. Select Add Current Image.

The image appears in a separate reference window.
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SETTING REFERENCE IMAGE OPTIONS
In the Reference Image Options panel, you can identify the location of your reference 
images, and set the maximum width and height for the images. To open this panel, select 
Options from the Tools menu. Then click the Reference Image tab.

You may also adjust the color corrections on a reference image. Do this by right-clicking on 
the image, and selecting Edit Color Corrections. The Color Correction Bar and the Profile 
Settings Bar will pop up, to give you the opportunity to adjust the color settings.
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SCANNING

WorkStream can connect to any Twain device. Twain is the standard method for connecting 
with most scanners.

SETTING UP YOUR SCANNER
The Scanner Options panel sets up your scanner and identifies where scanned files are to be 
stored.

To open this panel, select Options from the Tools menu. Then click the TWAIN Interface 
tab.
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Scanning
SCANNING IMAGES
Once you have set up your scanner in the Options panel, you are ready to scan images.

1. To scan an image, click the Scan button on the toolbar.

2. In the Scan Settings dialog box, click Select and chose from the list of Twain devices 
installed on your computer. If you do not see your scanner listed, it is probably not 
installed on the computer you are using.

3. In the Roll Name field, enter the name of the roll or order. 

All scan files created will automatically be prefixed with the Roll name and will be 
sequentially numbered starting with 1. For example. If the roll name is “order123-,” the 
files will be named: order123-1, order123-2, order123-3, and so on.

4. If you need to create a new folder for this roll or order, check the Create Folder check 
box. A folder with the same name as the roll name will be created before starting the 
scans.

5. In the Save Scans To field, browse for the location where you want the scans to be 
stored. 

If you have checked the Create Folder check box, WorkStream will create a folder in this 
location and store the scans in that folder. If you have not checked the Create Folder 
check box above, the scans will be stored directly into this location.
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RETOUCHING

All of the power of your retouching software can be accessed from within WorkStream. You 
simply identify what software you want to use for retouching.

Setting the retouching application
1. From the Tools menu, select Options.

2. Click the Retouching Application tab.

3. Click the Browse button (button with three dots) beside Retouching Application to 
browse for the program you want to use. Click OK.

Using the retouching application from WorkStream
1. Select the image you want to retouch.

2. Click the Retouch button on the toolbar.

Photoshop (or your favorite image manipulation software) opens automatically with the 
currently selected image. 
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Retouching
3. After you have finished working on the image, save it again. WorkStream sees that the 
image has been resaved and reloads it into WorkStream.
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OPTIONS

The Options pages (Tools | Options) give you access to WorkStream’s settings. They will 
be automatically set for you when you run the setup wizard, and after you run the 
configuration file from your photo lab. This section is provided for reference, should you wish 
to change some of the options.

Archiving Settings for pruning your database.

Color Management
(if permitted)

Determines how WorkStream displays and corrects the colors in 
image files. See page 86.

Database Identifies the location of the built-in database for storing order 
information. Sets timing of backups. Initiates database repair. See 
page 102.

Display Settings Customize the way you view images. See page 62.

File Structure Determines how your order files are stored. See page 99.

Image Locations Identifies storage locations on your network for image files. See 
page 100.

License View your Machine ID, License Code, and license expiration date 
here.

Materials Allows you to specify a list of materials that you will be using in your 
printer. Useful when configuring your printer.

Misc. Miscellaneous settings.

Order Summary 
Settings

Determine which items are displayed in your order summary. See 
page 21.

Product Window Rename, remove, or hide any of the top-level product tabs. See 
page 28.

Profile Locations 
(if permitted)

Identifies the location of working profiles and monitor profiles. See 
page 97.

Reference Image Identifies the location of reference images and sets their size. Sets 
the retouching application. See page 75.

Retouching App. Select the application to use for retouching images. See page 82.

Slideshow Customize your settings for your slideshow. See page 65.
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Options
TWAIN Interface Sets up your scanner and identifies where scanned files are to be 
stored. See page 80.

User Information This contact information will be included whenever orders are 
exported. It is the ONLY way the person importing the order will 
know how to contact you.
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PRINTING

WorkStream DS allows prints of a limited size to be made for proofing purposes. 

CONFIGURING YOUR PRINTER
To set up your printer in WorkStream, select Configure Printer from the File menu.

You may access your printer’s driver settings using the Configure Printer button on the 
dialog above. Note that WorkStream’s copy of your printer driver settings are different than 
Window’s copy of the settings, so you can make any changes you want through 
WorkStream’s Configure Printer button without having any effect on the settings that other 
programs use to print to you printer. See "Printer Driver Settings" on page 88 for more 
information about changing your settings using Configure Printer.
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Printing
Print Media
The Print Media tab (File | Configure Printer | Print Media) allows you to enter the 
characteristics of each of the papers you will be printing on, and to set which one is active. 

z Click Edit to view and change the Material Settings. Or, you may simply double-click 
the material you wish to edit.

z Click Remove to remove material you will no longer be using.
z Click Create/Copy to set up new print media.
z Check the box for the currently loaded paper. Every time you change the paper type 

in your printer, you must check the currently loaded type on the Print Media tab.

The Active Paper is the 
one loaded in your 
printer, and should be 
checked. Any prints 
submitted to your printer 
with that paper type or 
the "Any" paper type will 
be printed. Any prints 
submitted to your printer 
with other paper types 
will wait until their paper 
type is set as active on 
the Print Media page.
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The Material Settings page is shown below. You may configure the list of Brands and 
Types using Tools | Options | Materials.

Once you have set up your paper types, WorkStream will use the profiles you have assigned 
to them.

Printer Driver Settings
From the Printer Settings dialog (File | Configure Printer), press the Configure Printer 
button (on the Windows Printer tab) to view your WorkStream-specific printer settings.

Paper Type
Make sure that the paper type listed by your printer driver is a generic type, such as "Photo 
Quality Inkjet Paper." Listing a generic paper type allows you to avoid changing the paper 
type in the paper driver every time you load a different paper type in the printer. If your printer 
driver does not include a generic paper type in its drop down, choose the currently loaded 

Enter the output profile you wish to use. 
Managing your color with WorkStream allows 
you to create prints that match the colors on 
your screen.

Enter the paper width here. It will be 
automatically defaulted to the size of the 
paper currently in the printer. Note that this 
number is the printable area of the page, not 
the paper size.

Choosing a material brand and type will allow 
you to easily identify your paper in 
WorkStream.
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Printing
paper. Be sure to update the paper type both here and on the Print Media tab every time you 
change the type of paper in your printer.
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Paper Size
The size for the currently loaded paper should always be set in the printer driver. 
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Printing
Color Settings
If you are using WorkStream’s color management ("Color Management" on page 93), it is 
important to make sure that your printer driver is set not to adjust color. This option is often in 
the Advanced settings section of your printer driver.

If you are managing color in WorkStream, it is important to use profiles for all of your papers. 
For soft proofing, your monitor must be calibrated. Please see "Color Management" on 
page 93 for more information. 

MAKING A PRINT
There are two simple ways to create prints in WorkStream DS: 1) printing a proof, and 2) 
printing a product. Note that there are size limitations on the prints that can be created in 
WorkStream DS.

Printing Proofs 
1. Select the images you would like to print.

2. Select File | Print Proofs
3. Select the proof size you would like to print

4. Press OK.

Printing Products
1. Add the products you would like to print.

2. Select the printer and paper type for each product using the Order Destination and 
Paper Type drop-down menus on the Basic Settings Bar. 
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3. Click the Print button. Alternatively, use File | Print.
4. Select your printer.

5. Press OK.
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Color Management
COLOR MANAGEMENT

ZBE WorkStream software provides soft proofing capability. Soft proofing capability displays 
images on your computer monitor with the colors adjusted so that they match the colors on 
the final print. In other words, "What You See Is What You Get." 

In order to use the soft proofing capability in WorkStream, you need the following additional 
tools:

z Monitor Calibrator (available from Gretag Macbeth or Colorvision)
z Monitor calibration software (usually provided with the monitor calibrator)
z ICC Profiles for your monitor (created using the monitor calibrator and its software)
z ICC Profiles for your images (provided with Windows or Photoshop, and often 

embedded directly inside the image files themselves)

If a single one of these items is missing, soft proofing will not work correctly.

INPUT AND OUTPUT PROFILES
The Input Profile profile is also often called the Working Space or the Image Profile. The 
Input Profile is an ICC profile that specifies the color space in the original image file. In many 
cases the Working Space profile is contained directly inside of the image file. In this case the 
profile is said to be embedded. Embedding the profile is desirable because it simplifies the 
soft proofing process by eliminating the need to specify the Working Space profile separately. 

The Output Profile is also known as a Printer Profile. It is a file that specifies the colors your 
printer is able to reproduce on a specified output media. It is often possible to obtain profiles 
for your media from the manufacturer. Alternatively, you can build your own, using products 
from Gretag Macbeth, etc.

Obtaining Profiles
Adobe Photoshop supplies several common working spaces. In addition, photo-specific 
working spaces are available from

www.digitalattributes.com

Other questions can be addressed to Jon Meyer of Digital Attributes at

jon@digitalattributes.com

For a detailed description of Working Spaces and Color Management, consult Real World 
Color Management by Bruce Fraser, published by Peach Pit Press.

COLOR MANAGEMENT MODES
The Color Management options page (Tools | Options | Color Management) allows you to 
control your color management settings in WorkStream. These are global settings that get 
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applied to each image that is opened. From time to time, it may be necessary to adjust color 
management settings on a per-image basis. To do this, see "The ICC Profiles Bar" on 
page 97.

There are two modes for color management in WorkStream: Basic and Advanced. Basic 
mode allows you the power of a color managed workflow with minimal setup and learning. 
Advanced mode allows you to have complete control over your color management.

Basic
In this mode, color management is either on or off. You must specify only two things:

z A default input profile. This will only be used on images that don’t already have 
embedded profiles.

z A default printing ("output") profile. This will only be used when there is no profile 
associated with your output device. 

If color management is on, WorkStream soft proofs using the profile that Windows holds for 
your monitor. Instructions on how to change this profile are included on the Color 
Management page. 

NOTE: Some manufacturers give each of their profiles the same internal name. For example, some EPSON 
profiles show up as "Stylus Photo 2200 - EPSON". In order to figure out the paper type that 
corresponds to the tooltip, select a profile in the drop-down, and look at the tooltip. It will give you the 
filename, which usually includes the material type.
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Color Management
Advanced
This mode is recommended for users familiar with the principles of color management. 

You may choose from three color management policies:

Off Soft proofing and color management are not used. Images are displayed 
directly on the screen with no color adjustments. What you see on the 
screen will probably not match what you see in the final print.

Use Embedded 
Profiles

Soft proofing is turned on. WorkStream looks to the original image file to 
provide the Working Space (Input) profile. If Missing Profiles warnings 
are enabled and the original image is missing its embedded profile, then 
you will be presented with a warning and asked to select the input profile 
from a list of choices. 

Force Default 
Input Profile

Soft proofing is turned on. WorkStream ignores any embedded profiles 
and always uses the Working Space profile you have selected on the 
Color Management tab in the Options menu. If Profile Mismatches 
warnings are enabled and the image file contains an embedded profile 
that is DIFFERENT from your selected Working Space, a warning 
message will appear. 
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Color space warnings
Color space warnings are set using the Profile Mismatches check box in Advanced mode.

If you check this option, you will be warned whenever the embedded profile in the image file 
is DIFFERENT from the profile selected for your preferred Working Space. 

The non-matching profiles are identified and the options are listed.

Missing Profiles check box
This warning applies only if you have selected Use Embedded Profiles for your color 
management policy in Advanced mode. In this case, if the image you have opened does not 
have a profile embedded inside it, the Missing Profile screen appears. Select the profile you 
want to use for the Working Space for this image. 
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Color Management
PROFILE LOCATIONS
The Profile Locations page sets the location of the Working, Monitor, and Printing 
profiles. These are the folders that WorkStream looks in to find the ICC profiles used for soft 
proofing. When setting up color management, the list of profiles that you choose from are 
created from the ICC profile files located in these directories. 

To open this panel, select Options from the Tools menu. Then click the Profile Locations 
tab.

Working Profiles folder
WorkStream looks for input profiles in the Working Profiles folder, which can be located on 
an individual computer or in a shared network folder. If you have more than one computer 
running WorkStream, it is recommended that you put the Working Profiles folder in a shared 
network folder so it can be accessed by all computers.

Monitor Profiles folder
By default, the location for color profiles in Windows is one of the following:

C:\WINNT\System32\spool\drivers\color

C:\Windows\System 32\spool\drivers\color

Since the monitor profile is valid only for a particular monitor, there is no reason to share or 
move this profile. 

THE ICC PROFILES BAR
The ICC Profiles bar (Windows | ICC Profiles) allows you to adjust the color management 
settings for selected images. These settings do not effect your global Color Management 
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settings (Tools | Options | Color Management); the global settings are overridden by the 
ICC Profiles Bar settings for the selected images. 

In this dialog, there are three color management policies to choose from:
z Off: No color management will be applied to this image.
z Use Embedded Profile: This option can only be selected if there is an embedded 

profile.
z Use Input Profile: This option can only be selected if there is NO embedded profile. 

The Input Profile drop-down lists all the available profiles. 

For the Printing Profile, check the Use Printer checkbox to use the profile associated with 
your printer (recommended). Otherwise, uncheck the box to specify another profile. 
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Image and Database Storage
IMAGE AND DATABASE STORAGE

WorkStream uses the following storage methods and locations:
z Image files are stored on disk in folders. If you are running WorkStream on more than 

one computer, you should store these files on networked workstations so the images 
are accessible to all the computers.

z Information about your orders is stored in a database and some associated files. 
These files should also be accessible to all the computers running WorkStream.

STORING IMAGES

Organizing your image folders
You can store your image files in any manner or location you like. For optimum efficiency, 
however, WorkStream supports some preferred folder organization schemes for your image 
files. Organizing your image files according to one of these preferred schemes allows 
WorkStream to automate some of the file location and storage operations. For example, 
when creating a new order, WorkStream can automatically locate and open the image files 
for the order without requiring you to browse to locate the images. 

These folder organization schemes are simple and intuitive. While not mandatory, we 
strongly encourage you to adopt one of these schemes. Each WorkStream folder 
organization scheme utilizes one folder per order. All of the images for an order are stored 
together in a single folder. 
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Note: Using one of these organization schemes does not prevent you from creating orders with images from 
multiple folders.

Folder Organization Scheme 1: Alphabetical
Order folders are named by the order number. All customer order folders are stored 
under the customer name. Customers are organized by the first letter of the customer 
name (or customer ID). 

For example:   …\S\Smith\1234 (Order #1234 for customer "Smith")
…\D\Dove\982   (Order #982 for customer "Dove")

Folder Organization Scheme 2: Order Number
Order folders are named by the order number. There is no way to identify the customer 
from the folder name alone. (Of course the WorkStream database knows which customer 
this order belongs to.) 

For example:   …\1234 (Order #1234)
…\982   (Order #982)

Folder Organization Scheme 3: Alphabetical Customer + Order Number
Order folders are named by combining the customer name (or ID) with the order number. 
All customer orders will be grouped together when viewed by Windows Explorer in 
alphabetical order. Individual customer orders are not separated into a separate folder as 
with the Alphabetical scheme. 

For example:   …\Smith_1234 (Order #1234 for customer "Smith")
…\Dove_982   (Order #982 for customer "Dove")

The scheme you choose depends on the type and volume of work you do and the amount of 
time you want to keep the files on your system. Scheme 1 will work well for most 
photographers and photo studios, but if you have a high volume, you may prefer to use 
schemes 2 or 3. 

Image Storage Locations
Image files in professional photographic environments are large and consume tremendous 
amounts of disk storage. Hundreds of gigabytes of storage—or more—are common. As 
digital image storage requirements grow, image file servers are continually being replaced 
and upgraded. 

In order to simplify image file management, WorkStream identifies Image Storage Locations. 
Image Storage Locations are storage locations on your computer or network where 
WorkStream automatically stores and searches for the image files that it uses.

1. To set up an Image Storage Location, select Options from the Tools menu.
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Image and Database Storage
2. In the Options dialog box, click the Image Locations tab.

3. Click the New button to add a folder to the storage location. 

4. Navigate to the correct folder(s) and click OK to add them to the list. 

Note: Be sure to browse to the ROOT of the areas you identify as image storage locations. Once you have 
identified a location, WorkStream assumes that everything below the location you select can be used 
for image storage. 

Generating thumbnails automatically
When processing image files, speed counts. In order to display images quickly, thumbnails 
are created and opened in place of the original images. Since thumbnail images are much 
smaller than the original images, they are faster to open. WorkStream can automatically 
create thumbnail images for all image files stored in the image repositories.

1. To turn on this feature, from the Tools menu, select Options.

2. In the Options dialog box, click the Image Locations tab.

Click the New icon to add a folder.

Click the Up or Down arrows to move a 
folder around in the list.

Click the Delete icon to remove a folder.
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3. Check Automatically Generate Thumbnail Images.

(located above the image repository list). Automatic thumbnail generation can drastically increase the speed of your order processing. 

STORING ORDER INFORMATION
WorkStream has a built-in database for storing order information. The database contains 
your customer information and the details of all the orders created with WorkStream. By 
default, this database is located in the same folder as the WorkStream program. If you use 
WorkStream on only one computer, that location is probably fine. 

However, if you use WorkStream on more than one computer, the database should be 
created in a common location that is accessible to all computers running WorkStream. Make 
sure that the folder where the database is located is "shared" and accessible by all the 
computers running WorkStream.

Database location
1. From the Tools menu, select Options.

Check here to have 
WorkStream 
automatically 
generate thumbnail 
images.
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Image and Database Storage
2. In the Options dialog box, click the Database tab.

3. Click the New button (Top Left Icon).

4. Navigate to the database file and click Open.

The default database file is called WorkStreamDSdemo.mdb. This demo database is 
intended to provide examples as you learn to use WorkStream DS. You will want to 
create a new database for your own orders. You can name the database file anything 
you like, but we recommend it have the name WorkStream in it.

5. After you have selected the WorkStream database, click the Test Database Connection 
button.

It is a good idea to test the connection before using it.

6. When you have finished, click OK.

Compacting and repairing a damaged database
The database is critical to the use of WorkStream. In some cases, the database can become 
corrupted and need repair. Click the Compact and Repair Database button. The Compact 
and Repair operation can not always repair all damage in a corrupted database, but it is your 
best chance.

Over time databases can become inefficient and require internal reorganization and 
optimization. The Compact and Repair Database button also performs this function. You 
can and should use this function regularly, even if the database is not corrupted. This 
function should be performed every 200-500 orders. In most cases, weekly or monthly 
should be adequate. 

Click ... to locate the 
database.

Click here to test the 
connection to the 
database.
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Note that compacting and repairing a database is no substitute for backing up the database! 
The database file and the customer folder stored with it contain your entire WorkStream order 
history. If these are destroyed, a previous backup is your only recourse.

DIRECTORIES AND STORAGE LOCATIONS
The default directory structure for WorkStream DS is shown below. This directory structure is 
built when WorkStream is installed on a single computer. 

If you have more than one computer running WorkStream DS, we recommend creating a 
Shared Network Folder for storing some of the files and folders shown here. See "Network 
Common Storage" below for details.

NETWORK COMMON STORAGE
If you are using WorkStream on more than one computer, it is recommended that a shared 
network folder be set up. Everything to be shared between different WorkStream stations 
should be located in the shared network folder. This should include:

z WorkStream Database (MDB file)
z Order Files Directory (Customers folder)
z Reference Images (RefImages folder)
z Shared Profiles (ICC Profiles folder)
z Image Storage Locations
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Image and Database Storage
A recommended network directory structure is shown below.

By default, WorkStream looks in the WorkStream program directory for all of the folders 
shown above. After moving these folders to the Shared Network folder, it is necessary to tell 
WorkStream where to find these folders. Use the Tools-Options menu to set all of the 
necessary path locations. You will need to set:

z Database path (on the Database tab)
z Profile locations (on the Profile Locations tab) 
z Reference Image directory (on the Reference Image tab)

Shares required
In a multi-computer environment, it is necessary for all computers running WorkStream 
to have full access to the Shared Network Folder. If you are not sure how to set up this 
access, contact a computer system professional or network administrator to set up 
shares and access permissions.
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INDEX

A
Adding

images to an order, 54
reference image, 76, 77

Arbitrary, 58
Arbitrary Rotation, 58

B
Black and white print, 64
Borders, 52

C
Changing

color, 62
order of thumbnail images, 19
product settings, 32
thumbnail size, 18
view rotation, 74

Color
adjusting color on image, 62
management, 93
using floating image for comparison, 54

Color Corrections control, 71
Color space warnings, 95
Compacting database, 103
Configuration file, 7
Control bars, 11
Copying a view, 74
Creating

order, 12
view, 71

crop, default, 61
Cropping, 62

Copying Crops, 63
Match All Crops, 63
View All Crops, 63

Custom Products, 31
Customers View, 67

D
Database

location, 102
overview, 99
recalling order, 20
repairing, 103
saving order to database, 20
storing orders, 102

default crop, 61
Default views, 67
Deleting

products, 49
view, 73

Directories, storage, 104
DS bar, 72
DS View, 10, 13, 68

E
Exporting order, 23
External Data, 44

F
Features bar, 11
Floating an image, 54
Folder View, 69
Folders

organizing image folders, 99

I
ICC Profiles, 93
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Index
Image
adding reference image, 76, 77
adding to an order, 54
black and white, 64
color adjustment, 62
cropping, 62
floating, 54
organizing folders, 99
reference image, 75
removing from order, 17
renaming, 19
rotating, 57
sharpening, 65
storage locations, 100
storing, 99

Image button, 16
Images

adding to order, 16
browsing for, 13

Images bar, 71
Importing order, 25
Index prints, 31
Input Profile, 93
Installing WorkStream DS, 7
Interpolation, 52

L
Location

images, 13
profiles, 97

Locking a view, 73
Logos, creating, 32

M
Management, color, 93
Missing Profiles check box, 96
Monitor calibration, 93

N
Navigation bar, 11
Network common storage, 104
Non Photo Products, 31

O
Options, 84
Order

adding images, 16, 54
creating, 12
defined, 12
exporting, 23
importing, 25
printing a summary, 21
recalling from database, 20
removing images, 17
saving, 20
saving order information, 102
storing order information, 102

Order Lookup control, 72
Order Summary

modifying, 22
printing, 21

Organization schemes for image folders, 99

P
Packages, 31
Partial rotation, 58
partial rotation, 58
Printing

order summary, 21
print size, 52

Product
changing settings, 32
defined, 27
deleting, 49
organizing files, 27

Product groups, 27
Products

Custom, 31
Index Print Sheets, 31
Non Photo, 31
Packages, 31
Proofs, 30
Scaled, 31
selecting, 15

Products Panel, 11
Products, Creating, 40
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Profiles
locations, 97
missing profiles, 96
setting selections, 97

Proofs, 30

R
Reference image

adding, 76, 77
defined, 75
opening, 76
setting size options, 79

Removing images from order, 17
Renaming images, 19
Repairing database, 103
Retouching, 82
Rotating

Arbitrary, 58
image, 57

Rotation
changing view rotation, 74

S
Saving

images, 99
order, 20

Scaled Products, 31
Scanner, setting up, 80
Scanning, 80
Sharpening an image, 65
Size

changing thumbnail size, 18
print size, 52

Soft proofing, 93
Storage

image storage locations, 100
images, 99
location, 104
network common storage, 104
orders, 102

Switching between views, 70

T
Templates, Automatic Conversion, 37

Templates, Creating in Photoshop, 32
Templates, Creating in WorkStream, 36
Thumbnail images

adjusting size, 18
generating automatically, 101
sorting, 19

Toolbar, 11
Trader Cards, 44
Twain device, 80

V
View

changing rotation, 74
copying, 74
creating new, 71
default views, 67
deleting, 73
DS View, 10
locking, 73
switching between views, 70

Views button, 70

W
WorkStreamDSSetup.EXE, 8
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